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Federal Communications Commission
Radio Frequency Interference Statement

WARNING:  This equipment generates, uses, and can radiate radio
frequency energy and if not installed in accordance with the
instruction manual, may cause interference to radio communications.
It has been tested and found to comply with the limits for a Class A
computing device pursuant to Subpart J of Part 15 of FCC rules,
which are designed to provide a reasonable protection against such
interference when operated in a commercial environment.  Operation
of this equipment in a residential area is likely to cause interference
in which case the user, at his own expense, will be required to take
whatever measures may be required to correct the interference.
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Environmental
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Lincoln, Nebraska  68504 USA

Phone: 402-467-3576
FAX: 402-467-2819
Toll-free: 1-800-447-3576 (U.S. & Canada)
E-mail: envsales@licor.com

Declaration of Conformity

Manufacturer’s Address:  4421 Superior Street
Lincoln, Nebraska USA 68504

declares that the product

Product Name:  CO2/H2O Analyzer

Model Number(s):   LI-840

Product Options:   None

conforms to the following Product Specifications:

FCC CFR Part 15.109 Radiated Emissions, Class A
FCC CFR Part 15.107 Conducted Emissions, Class A

IEC 61326 : 1997/A2:2001 Radiated Emissions, Class A
IEC 61326 : 1997/A2:2001 Conducted Emissions, Class A
IEC 61000-4-2 : 1995/A2:2000: ESD, 4KV/8KV Contact/Air
IEC 61000-4-3 : 1995/A2:2000: Radiated RF Immunity, 10V/m
IEC 61000-4-4 : 1995/A2:2000: EFT/Burst
IEC 61000-4-5 : 1995/A2:2000: Surge
IEC 61000-4-6 : 1996/A1:2000: Conducted RF Immunity
IEC 61000-4-8 : 1993/A2:2000: H-Field Immunity, 30A/m
IEC 61000-4-11 : 1994/A2:2000: Voltage Dips

Supplementary Information:

The product herewith complies with the requirements of the EMC Directive 89/336/EEC.

Dave Dilley
Director of EngineeringDocument #53-07668

®

Manufacturer's Name:  LI-COR Inc.

December 1, 2003
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errors contained herein or for incidental or consequential damages in connection with the furnishing, performance, or use of this material.
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photocopied, reproduced, or translated to another language without prior written consent of LI-COR, Inc.

© Copyright 2003, LI-COR, Inc.
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Printing History
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1 General Description

What's What

This procedure should be followed if you have just taken delivery of your
LI-840.  Check the packing list to verify that you have received everything that was ordered
and that you have also received the following items:

� RS-232 Cable - (Part #392-04993), used to connect the LI-840 to your computer.

� 840-500 Data Communications Software - This Windows® 95/98/NT/2000/XP/ME
compatible software is used for communication between the LI-840 and a computer.  The
software is provided on CD.  A complete description of this software can be found in
Section 3, Operation.
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� Standard Spare Parts Kit (9980-012) - This kit contains replacement parts for the
LI-840.  As you become familiar with the analyzer you will learn which items to keep
close at hand and which items can be stored away.  The spare parts kit contains these
items:

Description Qty. LI-COR Part No.

Polyurethane Mounting Feet 4 234-02268
Mounting Screws 4 149-02610
Terminal Block 1 331-05273
Bev-a-line Tubing 12' 222-01824
Gelman Air Filter 2 9967-008
Quick Connect Unions 2 300-03123
Rapid Tube Fitting Nut 2 9861-036
2.0A Fuse 2 439-03952
Cleaning Kit, includes: 1 9980-013

3" Cleaning Swabs 5 610-05314
5" Cleaning Swabs 5 610-05315
O-Rings 4 192-00226
Pre-formed Optical Bench Tubing 4 6580-010
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Features

The LI-840 is an economical, high performance, non-dispersive infrared gas analyzer
designed to be used for a wide variety of applications.  Some of the LI-840's important
features include:
� A 14 cm (5.5") optical bench is used to obtain a CO2 measurement range of 0-3000 ppm

(parts per million, or µmol/mol) and an H 2O measurement range of 0-80 ppt (parts per
thousand, or mmol/mol).

� The optical bench is fully serviceable by the user; cleaning the optical bench is a simple
process, and does not affect the instrument's factory calibration.

� Simple Windows® software provides for easy user calibration and data output.

Precautions

� The optical bench is maintained at a constant temperature of about 50 °C.  Avoid direct
exposure to sunlight or extremely high temperatures that may elevate the temperature
inside the LI-840 case.

� The optical source is sensitive to vibration, and can be damaged by strong vibrations or
jarring.  Do not drop the LI-840, or expose it to severe mechanical shock.

� Do not use abrasive cleansers when cleaning the optical bench, as damage to the gold
plating may result.  Instructions for cleaning the optical bench can be found in Section 5.
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� Always filter air entering the LI-840.  Two Gelman filters are included in the spares kit.

Getting Started Tutorial

The following section briefly covers the basic steps you might follow to set up the LI-840 to
collect and record data.  Many of these steps are described in greater detail throughout this
manual.

1 Install the 840-500 PC Communications Software.

This software is used to set the zero and span of the LI-840, and to set up data communication
and data transfer parameters for viewing and logging data.  Installation instructions can be
found in Section 3, Installing the Software on Your Computer.

2 Determine your jumper settings for high and low alarm output, if
required.

There are 2 jumpers inside the LI-840 case (on the main circuit board) which toggle the high
and low alarm output between 0-5V (TTL levels) and an open drain condition.

The default jumper positions are set for 0-5V output for both high and low alarms.  This alarm
configuration is suitable for logic devices such as dataloggers.  To use the high and/or low
alarms to operate a relay switch, the jumpers should be reconfigured for open drain output.
See Section 2, Alarms, for a description of how to change the alarm jumper settings.
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If the default jumper positions are suitable for your application, or if you do not intend to use
the alarms, proceed to Step 3.

3

+ -

1 2 3 4 5 6 7 8 9 10 11 12 13 14

Connect a power source to the LI-840.

The LI-840 requires an input voltage of 12-30 VDC.  The power supply must be able to source
a maximum current drain of 1.2A (at 12 VDC).  After the instrument has warmed up it will
draw about 0.3A (at 12 VDC) with the heaters on.  Bare wire leads are connected to the
terminal strip at positions 1 and 2.  Connect the positive lead (usually red) to position #1 (12-
30VDC), and the negative lead to position #2 (GND).

NOTE:  Pull straight out on the face of the terminal strip to remove it; this can make it
easier to connect the wires.

4 Connect the RS-232 cable.

Connect one end of the serial cable to the 9-pin Serial I/O port on the LI-840 front panel, and
the other end to a serial port on your computer.  If you want to interface to a device with a 25-
pin serial port, a 9-pin to 25-pin adapter must be used; a gender changer may be required in
some cases, also.  Tighten the two screws on the ends of the serial cable.
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5 Connect other output device(s) if desired.

Output devices such as dataloggers and relay switches for high and low alarms are connected
via the terminal strip.  A complete description of the terminals can be found in Section 3,
Using the Terminal Strip.

6 Hook up the input air stream and external filter.

Remove the nut from the FLOW IN fitting and connect a short (12" or so) piece of Bev-a-line
tubing (in the spares kit).  Tighten the nut.  Place a Gelman filter (also in the spares kit) in the
sample airstream before it enters the FLOW IN port on the LI-840.   A user-supplied pump is
required to force air through the LI-840.

IMPORTANT:  Always install the external air filter before operating the LI-840.  Insert
filter into the input airstream before it enters the LI-840.  Failure to do this will lead to
contamination of the optical path.

When using the LI-840 for applications where sample air is particularly dirty, you may
consider stacking two filters in series.  For maintenance, replace the filter furthest upstream
from the analyzer with the filter closest to the analyzer and replace the filter closest to the
analyzer with a new filter.
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µPart # 9967-008

IN
1µmPTFE

IN

Air In

Air Out

Install the new filter(s) with the blue lettering facing away from the FLOW IN port.

The air inlet and outlet ports should be covered with the dust caps provided or attached to an
air line when the instrument is not in use.  This will prevent dust from entering the instrument
downstream from the filters where it can enter the optical path.

Replacement Gelman Acro 50 filters can be obtained from LI-COR (part #9967-008).
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7 Start the 840-500 PC Communications Software.

Click on the program icon to start the 840-500 program.  The 840-500 Main window appears.
Select Connect from the File menu.  Choose the serial port to which the LI-840 is connected,
and the data output interval.  Click the Connect button.  If the analyzer is connected properly,
data will appear in the main window.

8 Configure the analyzer.

Select Settings from the View menu.  The Settings window appears.  Choose a value for
signal averaging (the Filter field), between 0 and 20 seconds.  Set values for high and low
alarms and corresponding dead bands, if desired.  See Section 2 for a complete description of
the alarms.  If you are using an output device to collect data, choose the value to be output at
DAC 1 and/or DAC 2.  Make sure the Enable Heater and Pressure Compensation buttons are
enabled (checked), and click OK.
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9 Set the analyzer zero. 
 

NOTE:  The LI-840 is calibrated at the factory before shipping.  It is recommended, however, 
that you verify the calibration by connecting a gas with known concentration and reading the 
displayed value.  If the instrument needs to be calibrated, follow the steps below. 
 
Connect a dry, CO2-free gas to the input air stream.  Select Calibration from the View menu. 
Click on the H2O channel radio button to select the H2O channel.  Click the Zero H2O button.  
Select the CO2 channel radio button.  Click on Zero CO2.  After several seconds, a message 
will appear that indicates the IRGA is zeroed.   
 

10 Set the analyzer span. 
 

Connect an airstream with a known water vapor concentration (such as may be generated by 
the LI-610 Portable Dew Point Generator).  Select the H2O channel radio button.  Enter the 
dew point value of the H2O span gas, in degrees C, and click on Span H2O. 
 
Select the CO2 channel radio button.  Connect a span gas with known concentration of CO2 to 
the input air stream.  Note that your span gas concentration must not exceed the span range 
chosen in the Settings dialog from Step 8 above.  Enter the value of the span gas.  Click on 
Span CO2.  A message will appear indicating when the span calibration is completed. Click 
Close. 
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11 Set up the logging parameters.

Select Options from the Logging menu.  Choose the File Header(s) to be output with the data,
the values to be logged, the field delimiter, and log frequency.  Click OK.  Choose Start from
the Logging menu.  Enter a file name for the data file.  Click Save.

12 Set up the charting parameters, if desired.

Select Charting from the View menu.  Enter the value to be plotted, the Y-Axis min and max
values, X-Axis max, and time units to be displayed on each plot.  Click Start to begin
recording data.  Graphs with data will appear in the window and data will be logged to the file
designated in Step 11 above.

13 Choose Stop from the Logging menu to close the data file and
stop recording when you are done collecting data.
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2 Power On

Power On

The LI-840 can be connected to a constant source of AC power using a transformer that
provides 12-30VDC (14W maximum) to the LI-840.  If the LI-840 is powered On with a
voltage below 10.5 volts, the analyzer will not power up, and the Low Battery LED on the top
panel will illuminate.  The LI-840 will continue to operate with a low battery; there will,
however, be a corresponding reduction in performance.

Alarms

The LI-840 is equipped with high and low alarms, which can be configured as open collector
or 0-5V output (TTL levels) using jumpers on the main PC board (Figure 2-1).  The default
configuration is 0-5V output.  Figure 2-2 shows the position of the jumpers for each of the
two alarm conditions.

The alarms can be used for either CO2 or H2O concentrations; only one can be chosen at
a time, however.



Section 2

2-2 Power On

Alarm
Jumpers

Figure 2-1.  Location of alarm jumpers LK1 and LK2.
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Figure 2-2.  Position of jumpers for open drain and 0-5V output.
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In addition, a "dead band" value can be set in software for both high and low alarms.  To
understand how the alarms and dead band values work, look at the diagram below.

Elapsed Time

C
O

2 
C

o
n

ce
n

tr
at

io
n

, p
p

m

0

100

200

1000

900

Low Alarm = 100

High Alarm = 1000

High Alarm
activated

Low Alarm
activated

Low Alarm
deactivated

High Alarm deactivated

Dead Band = 100 ppm

Dead Band = 100 ppm

In this chart, the low and high alarm values are set to 100 ppm and 1000 ppm, respectively.
The dead band value in both alarms is set to 100 ppm.  When the CO2 concentration reaches
1000 ppm, the high alarm is activated, and remains active until the concentration drops below
900 ppm.  When the CO2 concentration falls below 100 ppm, the low alarm is activated, and
remains active until the concentration rises above 200 ppm.  Your choice for the dead band
value(s) depends on your application, and the fluctuation in CO2 concentrations over time.
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Note: Increasing the signal average value in software (see Settings Window; Options;
Filter in Section 3) can help reduce fluctuations in readings.

Alarm LEDs can be viewed on the top panel of the LI-840.  Terminals 3 and 5 on the terminal
strip are also connected to the High and Low alarms, respectively.  This is useful in cases
where you want to connect an audible alarm, for example, or a relay switch to operate another
device that will raise or lower the CO2 concentration to the desired level.  The schematic
diagram below shows how the high alarm could be connected to a relay switch that triggers an
exhaust fan in a greenhouse environment.  These relays could also be used to trigger devices
such as automatic dialers, alarms, pumps, and valves in industrial and other environments.



Section 2

2-6 Power On

LI-840
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A list of suppliers of electronic relay switches can be found in Appendix D.

NOTE:  Consult your local electrical codes before wiring, and/or have a professional
electrician wire your application.
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3 Operation

Installing the PC Communications Software on Your Computer

The 840-500 software is shipped on CD.  It requires that your computer have an RS-232 serial
(COM) interface, and Windows® 95/98/NT/2000/XP/ME.  The program runs on any true PC-
compatible computer.

An installation menu starts when you insert the CD into your CD-ROM drive.  Select Install
Software from the menu and follow the instructions.  If installation does not start, select Run
from the Windows Start menu, and select the LI840Setup.exe file on the CD.  When the
software has finished the installation procedure, a program icon will be placed in the Programs
menu.

NOTE:  To remove the software, go to the Control Panel and select Add/Remove
Programs.  Choose LI840 from the list of programs and click the Add/Remove button.
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Setting the Communication Parameters

LI-840 communication parameters are set automatically when the program is run.

Cabling

The serial cable included has 9-pin connectors on both ends; either end plugs into the 9-pin
connector (Serial I/O) on the front panel of the LI-840.  Use this cable to interface with your
computer's 9-pin serial port.  If you want to interface to a computer with a 25-pin serial port, a
9-pin to 25-pin adapter must be used.  To connect to a computer with a USB port, a 9-pin
serial to USB adapter must be used.

RS-232 Output

Data from the LI-840 can be transferred to a computer for analysis, printing or storage using
the RS-232 interface.  The LI-840 RS-232 port is configured as Data Terminal Equipment
(DTE) with no hardware handshaking, and is bi-directional, meaning information can be
transferred both into and out of the LI-840.

The 840-500 PC Communication Software that comes with the LI-840 is used to transfer data
and setup files between the LI-840 and the PC.
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Initial Setup

Click on the LI-840 program icon to start the program.  The LI-840 Main Window appears.
Select Connect from the File menu, or click on the connect icon on the toolbar, beneath the
File menu.  You are asked to select the serial port to which the LI-840 is connected, and the
output interval at which data are output (0.5 to 20 seconds, in 0.5 second increments).

Choose a COM port and the output interval and click Connect.  If the instrument is connected
properly, data will begin to appear in the Main window (below):
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The Main window displays the CO2 concentration (ppm) and H2O concentration (°C or ppt),
cell temperature and pressure, and the status of various LI-840 parameters.  There are also
three menus used to configure the LI-840, perform zero and span calibrations, and set up the
parameters for recording data.

Note that you can view H2O concentrations in units of degrees C or parts per thousand (1 ppt
= 1 mmol/mol).  To change the units in the Main window, go to the View menu and toggle the
H2O in ppt menu item on and off.  Alternatively, you can click the mouse on the H2O units
being displayed in the Main window to change the display.

The LI-840 parameters displayed in the Main window are as follows:

Parameter Description

Cell Temperature Temperature (°C) in the LI-840 optical cell.  This value should
remain near 50 °C when the heater is turned ON.

Cell Pressure Barometric pressure (kPa) measured in the LI-840 optical cell.  This
value can be used to correct measurements for the effects of
pressure fluctuations on gas density and band broadening.

Output Rate Displays data output rate chosen at connection.

Heater Shows status of heater (ON/OFF), which is used to maintain the
optical cell at a constant 50 °C.  The heater is turned ON/OFF in the
Settings window.
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Parameter Description

Pressure Comp. Shows whether pressure compensation is ON/OFF.  When ON,
measurements are corrected for the effects of pressure fluctuations
on gas density and band broadening.

Alarms Shows status of High and Low alarms, whose values are set in the
Settings window.  Alarms are enabled (ON), or disabled (OFF).

Filter Shows the current value for software signal averaging, set in the
Settings window.  The filter can be set from 0 (no signal averaging)
to 20 seconds.

DAC Output Displays source channels for DAC1 and DAC2, and the voltage
output range (0-2.5V or 0-5V).

PC Logging Shows "Off" if data are not being logged to a file, or "Logging"
when data are being logged to a file.
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Using the Toolbar
The toolbar in the Main window contains shortcuts for some of the commonly used menu
items:

Connect

Disconnect

Start
Logging

Stop
Logging

Pause
Logging

Settings Logging Options

Charting
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Settings Window - Setting Operational Parameters

The Settings window contains parameters related to initial setup of the LI-840, including the
resolution of the optical bench, signal filtering, high and low alarm setup, heater and pressure
compensation options, and DAC output sources.  Choose Settings from the View menu (or
click on the toolbar icon) to open the Settings window:
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CO2 span range.  
This can be 
scaled between 0 
and 99999 ppm.  
The measurement 
range for CO2 on 
the LI-840 is 0-
3000 ppm.

DAC output 
sources.  
Choose source 
to be output to 
DAC 1 and/or 
DAC 2

Software signal 
filtering is available 
from 0-20 seconds.

The heater should 
be enabled to 
maintain the 
optical bench at a 
constant 50 °C.

Pressure 
compensation 
should be enabled 
to compensate for 
gas density 
changes caused 
by variations in 
pressure. 

Disable the alarms 
here, set high and 
low alarm values, 
and high and low 
dead band values.

Use these radio 
buttons to choose 
CO2 or H2O as 
the alarm source.
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Options
Enable Heater
The Heater should be enabled to maintain the optical bench at a constant 50 °C.

Pressure Compensation
Enable the Pressure Compensation check box to automatically correct gas concentration
values for changes in cell pressure.  In most cases this should be turned on; disabling this
feature means that no pressure correction is desired in the gas concentration calculations,
which can lead to erroneous measurements.

Filter
Shows the current value for software signal averaging.  The filter can be set from 0 (no signal
averaging) to 20 seconds.  Note that increasing the filter decreases instrument noise but
reduces the response time.

DAC Output
Analyzer output for up to 2 values (None, CO2, H2O ppt, H2O °C, Cell Temperature, or Cell
Pressure) can be recorded by connecting a logging device to the terminal strip on the front of
the analyzer.  Output is linear, and is selectable at 0-5V or 0-2.5V.  Choose the DAC output
range and the source for DAC 1 and/or DAC 2.

The DACs in the LI-840 are bipolar, and will go slightly negative (~-0.100V).  This can
happen, for example, if the cell becomes contaminated or just from small random
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perturbations when the gas concentration is near zero.  See Section 5, Cleaning the Optical
Bench for instructions on cleaning the optical cell, should it become contaminated.

Voltage output is measured by attaching the positive lead from the logging device to terminal
9 (V Out 1), or terminal 7 (V Out 2) on the LI-840 terminal strip.  Connect the negative lead
to position 10, (GND), or position 8.

The CO2 concentration can be calculated from the DAC output voltage as follows:

CO V
C

V2
range

range

=








 3-1

where V is the measured voltage, Crange is the maximum value of the CO2 range selected (0 to
1000 ppm, 0 to 2000 ppm, etc.), and Vrange is the maximum DAC output for the selected
range (0-5V or 0-2.5V).

Example:  The voltage output is set for 0-5V output (Vrange), the maximum CO2 range
chosen is 2000 ppm (Crange), and the measured output voltage (V) is 2.9V.  To calculate the
CO2 concentration (no offset) from Equation 3-1 above,

CO 2.9V
2000 ppm

5V2 = 



 3-2

= 1160 ppm.
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The H2O concentration (ppt) can be calculated from the DAC output voltage as follows:

H O V
H

V2
range

range

=








 3-3

where V is the measured voltage, Hrange is the maximum value of the H2O channel (80 ppt),
and Vrange is the maximum DAC output for the selected range (5.0 or 2.5 volts).

Example:  The voltage output is set for 0-5V output (Vrange), the H2O range is fixed at 80 ppt
(Hrange), and the measured output voltage (V) is 2.9V.  To calculate the H2O concentration
(no offset) from Equation 3-3 above,

H O 2.9V
80 ppt

5V2 = 



 3-4

= 46.4 ppt.

The H2O concentration (dewpoint, °C) can be calculated from the DAC output voltage as
follows:

DP V
100 C

V
C

range

= °







 − °50 3-5
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where V is the measured voltage and Vrange is the maximum DAC output for the selected
range (5.0 or 2.5 volts).

Example:  The voltage output is set for 0-5V output (Vrange) and the measured output voltage
(V) is 2.9V.  To calculate the H2O dewpoint from Equation 3-5 above,

DP 2 V
100 C

5V
C= °



 − °.9 50 3-6

= 8 °C.

Converting Voltage Output to Cell Temperature
Cell temperature can be calculated from the DAC output voltage as follows:

Temp. V
100 C
Vrange

= °





3-7

where V is the measured voltage output and Vrange is the maximum DAC output for the
selected range (5.0 or 2.5 volts).

Converting Voltage Output to Cell Pressure
Cell pressure can be calculated from the DAC output voltage as follows:
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Pressure V
1 5 kPa

Vrange

=






1 3-8

where V is the measured voltage output and Vrange is the maximum DAC output for the
selected range (5.0 or 2.5 volts).

Converting Current Output to ppm CO2 or ppt H2O
Current output can be measured by connecting the positive input of the data logging device to
positions 11 or 13 (4-20 mA 1 or 4-20 mA 2), and the negative input to position 12 or 14
(GND).  The current output at positions 11 and 13 is non-isolated, and is rated to drive a 250
ohm load.

Note that these channels mirror their respective voltage output channels; current output
channel 1 uses the variable chosen for the DAC 1 source, and current output channel 2
uses the variable chosen for the DAC 2 source.  Similarly, a voltage output of 0 volts
corresponds to a current output of 4 mA, and when the voltage outputs are at full scale
(2.5 or 5 V), the current output will be 20 mA.

To convert current output (I) to units of ppm CO2 or ppt H2O in your computer or other
output device, the following equation can be used:
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CO
C

16
I 42

range= −( ) 3-9

where Crange is the maximum available resolution (3000 ppm CO2 or 80 ppt H2O), and I is the
measured current output in mA.

Example:  You have chosen 3000 for the CO2 range of the LI-840.  The measured current
output is 16.25 mA.  To convert to ppm CO2 or ppt H2O:

CO
3000

12 = −( )
16

6 25 4. 3-10

= 2296.875 ppm.

H O
80

12 = −( )
16

6 25 4. 3-11

= 61.25 ppt.

CO2 Span Range
The span range entry field determines the maximum CO2 range over which the LI-840 will
make measurements.  The factory calibration range for the LI-840 is 0-3000 ppm.  Note that
there is a benefit to selecting a narrower range if that range is adequate for your experiment.
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The narrower range provides better resolution in terms of the digital-to-analog converter
(DAC).  For example, if you choose a range of 0-1500 ppm, each step of the DAC is able to
resolve twice as many data points as compared to the 0-3000 ppm range, which results in
better resolution.

Alarms
Allows you to enable/disable the alarms, and enter high, low, and dead band values.  A
complete discussion can be found in Section 2, Alarms.

Using the Terminal Strip

The terminal strip is located on the front panel of the LI-840.  To connect the wires, insert the
bare wire end into the appropriate terminal and tighten the screw above that terminal using the
small flat head screwdriver in the spare parts kit.  The front face of the terminal strip can be
removed to aid in connecting the wires by pulling straight out on the face.

1 2 3 4 5 6 7 8 9 10 11 12 13 14
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The terminal positions are as follows, reading left to right:

Terminal Label Description

1 12-30 VDC Voltage In, 12-30 VDC
2 GND Ground
3 High Alarm High Alarm
4 GND Ground
5 Low Alarm Low Alarm
6 GND Ground
7 V OUT 2 Voltage output channel 2
8 GND Ground
9 V OUT 1 Voltage output channel 1
10 GND Ground
11 4-20 mA 2 Current output channel 2
12 GND Ground
13 4-20 mA 1 Current output channel 1
14 GND Ground
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Charting Window

Select Charting from the View menu to open the Charting window (below).  This is the
window in which you can set up the parameters for plotting your data.  Two charts can be
plotted simultaneously, using Y axes on either side of the chart.
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Series 1
The Series 1 options are used to plot a chart with the Y axis on the left side of the chart.
Choose the value to be logged, and set the maximum and minimum values for the Y axis.
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Series 2
The Series 2 options are used to plot a chart with the Y axis on the right side of the chart.
Choose the value to be logged, and set the maximum and minimum values for the Y axis.

X-Axis Max
Sets the maximum value for the X axis (Time).  The units for the X axis can be seconds or
minutes.

Press Start at any time to view the chart layout and begin displaying data.  Note that you must
press Stop to make changes to the chart parameters, and then press Start again to resume data
display.
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Diagnostics Window

Select Diagnostics from the View menu to open the Diagnostics window (below).  This
window displays the current LI-840 internal software version number, the input voltage, and
raw absorption values.
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Logging Data

Start Logging
Opens the Log File Destination dialog, where you enter a file name for the data file.  The file
extension .txt is added automatically.
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Stop Logging
Stops data logging.

Pause Logging
Pauses logging of data until Start is chosen from the Logging menu again, or the Start button
on the toolbar is pressed.

Options
Opens the Logging Options window, where you can configure the data output options.
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As configured above, the data output would appear similar to that shown below.

File Headings

Log Values

System
Time (1s
log rate)

CO2 H2O Cell
Temp.

Cell
Pres.

CO2
absorption

H2O
absorption
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Calibration Window - Setting the Zero and Span

Select Calibration from the View menu to open the Calibration window.  This is the area in
which you set the zero and span of the LI-840.
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It is recommended that you perform the zero calibrations first, followed by the span 
calibrations.  To zero, flow a dry, CO2-free gas through the LI-840, and make sure the optical 
cell is completely purged.  Press the Zero CO2 button.   
 
The display will show ZERO, and the text in the Calibration window is greyed out.  The zero 
will be set electronically, and the current date will be entered in the "Last zeroed on" field 
when completed.  Repeat for the H2O channel. 
 
To span, connect a span gas of known concentration to the input air stream.  Make sure the 
cell is purged, enter the value of the span gas, and click on Span CO2. 
 
The display will show SPAN, and the text in the Calibration window is greyed out.  The span 
will be set electronically, and the current date will be entered in the "Last spanned on" field 
when completed.  Repeat for the H2O channel using an airstream of known dew point. 
 

Coefficients Page 
The LI-840 uses a fifth order polynomial for the CO2 calibration, and a third order polynomial 
for H2O calibration.  The Coefficients page displays these factory-determined calibration 
coefficients, as well as those for band broadening and cross sensitivity, and coefficients for 
the internal pressure transducer.  These coefficients are fixed at the factory. 
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The calibration coefficients are unique to each instrument, and may be found on the 
calibration sheet shipped from the factory.  In most cases you will not want to alter any of 
these values. 
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A description of the band broadening and cross sensitivity corrections can be found in
Appendix B, Equation Summary.

Advanced Page
The calibration constants for CO2 and H2O zero and span calibrations are found on the
Advanced calibration page.  These constants are stored to a file on the computer by clicking
on Save to Defaults.  Click Load Defaults to restore the values in this window using the file
on the PC.  If new constants are entered in this window, click Send Constants to send the
values to the LI-840 for implementation.

In most cases you should not change the values in this window; see Appendix B, Equation
Summary for a description of the terms used in this window.
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Connecting the LI-840 to the LI-1400 Datalogger

Fct

On/Off

Setup Enter

7

4

1

0

8 9

5 6

2 3

Esc

EEX

View

Shift

M P

T

X Y Z

VU

RQ

N O

J

S

W

I

L

HG

K

C

F

B

E

A

D

The following example shows how you can connect the LI-840 to a datalogging device such
as the LI-COR Model LI-1400 DataLogger to collect analog data and convert to meaningful
CO2 and/or H2O values.  As mentioned earlier, voltage output from the LI-840 is linear;
converting analog data into ppm CO2 simply requires multiplying the raw mV output by a
conversion factor, which is dependent upon the selected voltage output range, and the
maximum CO2 resolution available (set in software between 0-3000 ppm).  In general, the
conversion takes the form

CO V
C

V2
range

range

=






3-7

where V is the measured voltage, Crange is the maximum value of the CO2 range selected (0 to
1000 ppm, 0 to 3000 ppm, etc.), and Vrange is the maximum DAC output for the selected
range (0-5V or 0-2.5V).

For example, if the voltage output is set for 0-5V output, the scaled CO2 range is 2000 ppm,
and the measured voltage output is 2.9V, the equation would take the form

CO 2.9V
2000 ppm

5V2 = 





3-8
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= 1160 ppm.

This general equation can be converted into simple multipliers, based on the two known
voltage output ranges, and the value for maximum CO2 resolution (0-3000).  This multiplier
can then be entered in the data logging device to convert raw voltage to CO2 values.  Table 3-
1 lists the appropriate values for this multiplier; simply choose your DAC output range in the
second row, and then select the LI-840 maximum CO2 range in the first column; follow across
to find the appropriate multiplier.

Table 3-1.  Multipliers for Converting Voltage Output to CO2 Readings

DAC Output Range

Crange

0-1000 ppm

0-2000 ppm

0-3000 ppm

200

400

600

0-5V

Multiplier (ppm/volt)

400

800

1200

0-2.5V

The LI-1400 can be used to monitor voltage signals up to 2.5 volts with 76 microvolt
resolution in real time and convert them into meaningful engineering units shown on the
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display.  Alternatively, the LI-1400 can be configured to automatically log these data over
extended periods of time and later dump the results to a computer for further analysis.

Access to the voltage channels require the 1400-301 Terminal block.  Voltage channels are
designated by the letter “V” and sequentially numbered V1-4.  The lead from LI-840 terminal
#7 or #9 should be attached to one of the LI-1400 terminals labeled V1, V2, V3, or V4, while
the lead from terminal #8 or #10 should be attached to one of the LI-1400 terminals labeled ↓.

The following example shows how you can set up the LI-1400 Data Logger to collect raw
voltage output from the LI-840 and convert to CO2 values.

1.  Set the voltage output of the LI-840 for 2.5V output as described in Section 3, Analog
Output.

2. In the LI-1400, configure V1 channel as General for CO2.

3. Enter a description, such as CO2.

4. Set Math = Poly(nomial) and press Ent(er).

5. Set description as desired, a1 = multiplier from Table 3-2 above, a0, a2-a5 = 0.  When
finished, press Esc to return to the main configuration list.

6. Set Oper(ator) = none.
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7. Enter a Label such as ppm for the units.

8. Set Average=1 sec or as desired.  CO2 will now be displayed on channel V1.

To log CO2 automatically, follow the remaining steps:

9. Set Log Routine to the desired log routine.

10. Set Calc=Mean.

11. To capture the minimum and maximum CO2 values, set MinMax accordingly.

12. TCoef has no effect when Calc=Mean.  It is used only when integrating.
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4 Theory of Operation

System Overview

The LI-840 CO2/H2O Gas Analyzer is an absolute, non-dispersive, infrared (NDIR) gas
analyzer based upon a single path, dual wavelength, infrared detection subsystem.  The CO2
and H2O measurements are a function of the absorption of IR energy as it travels through the
optical path.  Concentration measurements are based on the difference ratio in the IR
absorption between a reference and sample signal.  Reference and sample channels measure
infrared gas absorption in a single path through the use of narrow band optical filters with
appropriately selected bands.  The CO2 sample channel uses an optical filter centered at 4.26
micrometers, corresponding to the absorption band for CO2.  The reference channel for CO2
has an optical filter centered at 3.95 micrometers, which has no absorption due to CO2.  The
H2O sample channel uses an optical filter centered at 2.595 micrometers, corresponding to the
absorption band of H2O.  The reference channel for H2O has an optical filter centered at 2.35
micrometers, which is outside the absorption band of H2O.
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The instrument uses digital signal processing techniques to determine the temperature and
pressure corrected CO2 concentration based on the optical bench signals using a ratiometric
computation.  The data are passed through a 5th order polynomial (CO2) or 3rd order
polynomial (H2O) that performs linearization of the detector signal to a mole fraction in air
given in µmol CO2 per mole of air, and mmol H2O per mole of air (ppt).

Data output is provided in a digital format through an RS-232 interface that supports
connection to an external computer.  The instrument comes with a Windows®
95/98/NT/2000/XP/ME compatible application for instrument configuration, control, data
collection and display.  Analog signals are available through a terminal block for collection by
a data logger or similar means.

Optical Bench System

The LI-840 CO2/H2O Gas Analyzer optical path is a thermostatically controlled IR detection
system.   The optical bench operation is based upon a broad band IR source and a pyroelectric
detector.   The source is mounted in a parabolic reflector to collimate the light and increase
energy throughput down the optical path to the detector.  The reflector and optical path are
gold plated to further increase energy transmission.  The detector is a pyroelectric device that
operates based on thermal energy received.  The narrow band optical filters allow only the
two wavelengths of interest to illuminate the detector, allowing for the determination of CO2
and H2O concentrations in the presence of other infrared absorbing gases.
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The detector responds to thermal energy, so it is necessary to precisely regulate the detector
temperature.  This allows for differentiation of thermal gradient noise from the received
signals from the optical path.  The detection subsystem is shown in Figure 4-1.

Ribbon Cable
Connector

Gold Plated
Optical Path

Gold Plated
Parabolic Reflector

Source Detector

Broad Band IR Source

CO2 Filters
3.95 & 4.26 µm

H2O Filters
2.35 & 2.59 µm

Pressure Transducer

Heating Element Heating Element

Gas Inlet Gas Outlet

Thermistor Thermistor

Figure 4-1.  Schematic diagram of LI-840 optical bench.
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The optical bench has a thermostat that maintains a constant operating temperature of 50 °C.
A feedback loop is used to regulate the optical bench temperature.  As shown in Figure 4-1,
two thermistors, located in the source and detector housings, measure the present temperature.
The thermistors are monitored as part of the control loop to determine corrections necessary in
the thermal balance.  Two heating elements are the sources of thermal energy into the source
and detector housing.  The optical path is in mechanical contact with the source and detector
housing and thereby achieves thermal equilibrium.

The bench requires approximately 10 minutes to achieve the specified thermal temperature.  A
longer period of approximately 20 minutes is required to bring the performance of the
detection system to within 1 to 2% of reading.  As shown in Figure 4-1, the detector housing
has a pressure transducer integrated into the housing design.  Part of the CO2 concentration
calculation depends on the pressure observed in the optical path, measured with an in-line
pressure transducer.  Many parameters can affect the pressure and thus the concentration
reading.  The processing center in the analyzer reads the pressure reading as part of its data
collection task and uses this information in the concentration calculation.  The gas flow enters
the source housing, passes down the optical path and exits at the detector housing.  The
maximum flow rate for the analyzer is approximately 1 liter/min.
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Another key parameter in the concentration calculation is the gas temperature in the optical
path.  It is assumed in the analyzer operation that the gas temperature will equilibrate to the
optical bench temperature (50 °C) by the time it enters the optical path.  Since the instrument
performs temperature and pressure corrections as part of the concentration calculation, this
assumption is very important.  To cause the sample air to equilibrate to the optical bench
temperature, an airflow pattern is created with sufficient eddy currents to cause thermal
equilibration.

The optical bench is mounted in a foam enclosure to accomplish two purposes.  The first is to
assist in maintaining the controlled thermal environment required for the optical bench as
described above.   The second function of the foam enclosure is to protect the optical bench
from mechanical shock and vibration that might damage the mechanically sensitive
components.   The foam enclosure is supported by a optical bench “tray” which is in turn
attached to the main circuit board (PCB).  The optical bench is mechanically de-coupled from
the case by creating the s-bend in the Bev-a-line tubing from the external fittings to the optical
bench gas inlet and outlet connectors.   The electronic interface to the source and detector is
achieved through printed circuit boards mounted directly to the source and detector housings,
respectively.  The PCBs connect the main PCB to the source and detector PCBs via a ribbon
cable.  This achieves the mechanical isolation desired for the optical bench.

A 14 cm (5.5") optical bench provides a CO2 measurement range of 0 – 3000 µmol/mol
(ppm), and an H2O measurement range of 0-80 mmol/mol (ppt).



Maintenance 5-1

5 Maintenance

Cleaning the Optical Bench

The LI-840 optical bench can be removed and cleaned if necessary.  If the optical path
becomes dirty it may become difficult to span the analyzer.  Excessive zero drift may also be
observed if the optical path becomes dirty.  Follow these steps to clean the optical bench:

1. Turn the LI-840 off.  Remove the six screws on the LI-840 top panel and remove the
cover.  Note that these screws are not molded into the case and may fall out.

2. Unscrew the tube retaining nuts on the inner air port fittings.  Remove the tubing from
both air ports.  Leave the tubing connected to the source and detector housings.

3. There are ribbon cables connected to the circuit boards on the source and detector
housings, as shown below.  Pull straight out on the connector that is attached to each
ribbon cable.  The optical bench can now be removed from the foam casing.
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Source
Detector

Air In Air Out

PCBPCB

Optical Bench

Hose Barb

Bev-a-line Tubing
Ribbon Cable
Connector

4. There are four screws on the source and detector circuit boards that must be removed.
Remove the four screws in the corners of the boards, as shown below (they are slightly
larger than the other four screws).  Do not remove the remaining four screws.
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Remove these
4 screws

5. The source and detector housings (with attached circuit boards) can now be removed.
The bench will appear as shown below.  It is a good practice to replace the O-rings when
cleaning or replacing the optical path.

O-ring

Top View

End View
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�

Optical 
Path Swab

Reflector
Swab

6. There are a number of swabs in the spare parts kit (see at left).  Dip one end of the swab
into a 50:50 ethanol/water solution and carefully swab both ends of the optical bench,
until there is no more visible residue.  A mild solution of dish washing type soap and
water will also work.  Do not use abrasive cleansers, as they can irreparably damage the
gold plating on the optical bench.

7. Use a reflector swab and carefully swab the gold-plated concave surface of the source
housing, if necessary.

8. If you need to clean out the hose barbs and/or replace the tubing connected to the source
and detector housings, use a small pair of diagonal cutters to remove the tubing from the
hose barbs.  Use the cutters to pinch the tubing parallel to the hose barb axis, and then
pivot the cutters over the hose barb tip; the tubing will pull off of the hose barb.  Be very
careful not to cut the tubing or scratch the hose barb with the cutters, as subsequent
tubing connections may leak.

9. Let the optical bench dry.  Re-assemble the bench, making sure the O-rings are in place
on both ends of the bench.  Note that the orientation of the cylinder is not important;
either end can be inserted into the source or detector housing.

10. Re-assemble the LI-840 case.  Make sure that the foam insulation on the inside top cover
is positioned over the optical bench; it is required for thermal stability.

11. Perform zero and span calibrations as described in Section 3, Calibration Window.
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Changing the Fuse

The LI-840 power supply is protected by a 2.0A 250V, 5 × 20 mm fast-blow type fuse located
inside the case.  If the battery fails to power the LI-840, and will not light the Power LED on
the top panel, check to see if the fuse has blown.

To check the fuse, remove the six screws on the top of the LI-840.  The fuse is located on the
main circuit board, near the Flow In port, as shown below.  Replacement fuses (part #439-
03952, in the spares kit) plug into the fuse holder; no soldering is required.  Replace the fuse
and reassemble the LI-840 case.

Fuse
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Note on Infrared Source Replacement

The infrared source in the LI-840 is rated for more than 18,000 hours of life.  Should the
source fail, a replacement can be obtained from LI-COR.  The source can be replaced in the
field; however, it should be noted that changing a source has the potential of degrading the
accuracy specification for CO2 to as much as 3% of reading.  The H2O channel should remain
within the published specification.

If the source fails, the instrument can be returned to LI-COR for replacement and factory
recalibration.  LI-COR has also developed a simple field recalibration procedure that requires
only two verified non-zero concentrations of CO2.  A simple software application and
instructions for replacing the source and performing this field calibration can be obtained free
of charge from LI-COR.
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A Specifications*

CO2

Measurement Range: 0-3000 ppm
Accuracy: Better than 1.5% of reading
Calibration Drift

Zero Drift: <0.15 ppm/°C
Span Drift: < 0.03 %/°C
Total Drift at 370 ppm: <0.4 ppm/°C

RMS Noise at 370 ppm with 1 sec signal filtering: <1 ppm
Sensitivity to water vapor: < 0.1 ppm CO2/ppt H2O

H2O

Measurement Range: 0-80 ppt
Accuracy: Better than 1.5% of reading
Calibration Drift

Drift at 0 ppt: <0.003 ppt/°C1



Appendix A

A-2 Appendix A

Span Drift at 10 ppt: <0.06 %/°C2

Total Drift at 10 ppt: <0.009 ppt/°C3

RMS Noise at 10 ppt with 1 sec signal filtering: <0.01 ppt
Sensitivity to CO2: <0.0001 ppt H2O/ppm CO2

Measurement Principle: Non-Dispersive Infrared
Traceability: Traceable gases to WMO standards for CO2. NIST traceable LI-610 Portable Dew Point Generator for H2O
Pressure Compensation Range: 15 kPa-115 kPa
Maximum Gas Flow Rate: 1 liter/min
Output Signals: Two analog voltage (0-2.5V or 0-5V) and two current (4-20mA)
Digital: TTL (0-5V) or Open Collector
DAC Resolution: 14-bits across user-specified range
Source Life: ~18,000 Hours
Power Requirements: Input Voltage 12-30 VDC

1.2A @ 12V (14W) maximum during warm-up with heaters on
0.3A @ 12V (3.6W) average after warm-up with heaters on

Operating Temperature Range: –20°C to +45°C
Relative Humidity Range: 0 to 95% RH, Non-Condensing
Dimensions: 8.75" × 6" × 3" (22.23 × 15.25 × 7.62 cm)
Weight: 2.2 lbs (1 kg)

1 Zero drift is the change with temperature at 0 concentration.
2 Span drift is the residual error after re-zeroing following a temperature change.
3 Total drift is the change with temperature without re-zeroing or re-spanning.

* Specifications subject to change without notice
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B Equation Summary

General Form

The LI-840 computes CO2 and H2O concentrations using an equation of the form

c = f (αg(α, P)) (T + 273) (1)

where c is concentration, f() is the calibration polynomial, α is the absorptance, g (α,P) is the pressure correction, and T is
absolute temperature of the gas in the cell. Absorptance is computed from

α = −






1
V
V

Z S
o

(2)

where V and Vo are the raw detector sample and reference readings. Z is the zeroing parameter, and S is the spanning parameter.



Appendix B

B-2 Appendix B

H2O Equations
Absorptance αw for water vapor is computed from

αw
w

wo
w w

V
V

Z S= −






1 (3)

where Vw and Vwo are the sample and reference raw detector readings, Zw is the zero parameter, and Sw is the span parameter.
The pressure correction for water vapor is an empirical function gw() of absorptance and pressure P:

g P
P

P
P
P

W w
o

w
o

( , )
.

α
α

=
+ −











1 0 8 1
(4)

The value of Po is 99 kPa. When the pressure correction is not enabled, gw() is simply 1.0. The value of water absorptance that is
output by the LI-840 is the product of absorptance and the pressure correction: αwgW(αw,P).

Water vapor concentration W (mmol mol-1) is computed from

W = fw(αwgW(αw, P))(T + 273) (5)

where fw(x) is a third order polynomial whose coefficients are given on the calibration sheet.
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fw(x) = aw1x + aw2x2 + aw3x3 (6)

T is the temperature of the LI-840 optical bench, typically 51.5 °C.

CO2 Equations
The measurement of CO2 is a bit more complicated than for H2O, because of the influence of water vapor. There is a slight direct
cross sensitivity in the CO2 signal to H2O that is measured at the factory and accounted for in the computation of absorptance
(Equation 7). There is also a band broadening effect that is accounted for in the computation of concentration (Equation 10).

CO2 absorptance αc is computed from

αc
c

co
wc

w

wo
c c

V
V

X
V
V

Z S= − + −




















1 1 (7)

where Vc and Vco are the raw detector signals for sample and reference, Zc and Sc are zero and span parameters, and Xwc is a
cross sensitivity parameter for the effect of water vapor on CO2. Its value is reported on the calibration sheet as “XS=”.

The empirical pressure correction function gc() is a function of CO2 absorptance and pressure:

When P = Po, gc() = 1.

When P < Po
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g P

A B
z z

c c
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p
P
P
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where a = 1.10158, b = -6.1217 × 10-3, c=-0.266278, d=3.69895, and z=0.5.

When P > Po

g P

A B
z z

A B
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c

( , )α
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−
−



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−




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1 1

1
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(9)
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p
P
P
o=

CO2 concentration C (µmol mol-1) is computed from

C f
g P

W
W Tc

c c c=
( )





+

α α
ψ

ψ
,

( )
( )( )273 (10)

where fc(x) is a 5th order polynomial whose coefficients are given on the calibration sheet.

f x a x a x a x a x a xc c c c c c( ) = + + + +1 2
2

3
3

4
4

5
5 (11)

ψ(W) is the band broadening correction for water vapor.

ψ ( ) ( )W b
W

w= + −1 1
1000

(12)

The band broadening coefficient bw has been determined to be 1.45 for the LI-840.

Symbol Summary

Many of the quantities described in the above section are available from the LI-840. Table 1 summarizes.
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Table 1: Symbols

Symbol XML Tag: <LI840>+ Description

αw H2O absorptance

αw gW(αw,P) <DATA><H2OABS> Pressure corrected absorptance of H2O

W <DATA><H2O> H2O (mmol mol-1)

P <DATA><CELLPRESS> Pressure (kPa)

T <DATA><CELLTEMP> Temp (C)

αc CO2 absorptance

αcgc(αc,P) <DATA><CO2ABS> Pressure corrected absorptance of CO2

C <DATA><CO2> CO2 (µmol mol-1)

Vw <DATA><RAW><H2O>

Vwo <DATA><RAW><H2OREF> Raw detector readings

Vc <DATA><RAW><CO2>

Vco <DATA><RAW><CO2REF>

aw1...aw3 <POLY><H2O> Calibration coefficients
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ac1...ac5 <POLY><CO2> Calibration coefficients

Zw <CAL><H2OKZERO>

Sw <CAL><H2OKSPAN> Zero and Span values

Zc <CAL><CO2KZERO>

Sc <CAL><CO2KSPAN>

xwc <POLY><XS> Cross sensitivity coefficient

bw <POLY><BB> Band broadening coefficient
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C Pin Assignments

DB-9 Connector

 

1

6

2

3

8

7

4

9

5

Data (RXD)

Data (TXD)

Signal Ground (SG)
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D Suppliers

Although the LI-840 has no internal chemicals to replace, the following suppliers may be useful for obtaining chemicals for
generating a chemical zero gas.  The company names, addresses, and phone numbers are the most current we have at the time of
this printing.  In some cases the information may change without notice.

Soda Lime (6-12 mesh) and Magnesium Perchlorate (Anhydrous) Mg(ClO4)2

GFS Chemicals
www.gfschemicals.com
P.O. Box 245
Powell, OH  43065
Phone: 614-881-5501
FAX: 614-881-5989
Toll free: 800-858-9682

Soda Lime: Part #66352

Mg(ClO4)2: Part #49001 (500g,
<8% water)
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Fisher Scientific
www.fishersci.com
711 Forbes Avenue
Pittsburgh, PA  15219-4785
Phone: 201-467-6400
FAX: 201-379-7415
Toll free: 800-776-7000
Toll free FAX: 800-926-1166

Soda Lime: Part #S201-212
(LI-COR Part #9960-071)

Mg(ClO4)2: Part #M54-500 (500g)

Thomas Scientific
www.thomassci.com
P.O. Box 99
Swedesboro, NJ  08085-6099
Phone: 609-467-2000
FAX: 609-467-3087
Toll free: 800-345-2100
Toll free FAX: 800-345-5232

Soda Lime: Part #C703-B76

Mg(ClO4)2: Part #C260-M61
(Dehydrite, 500g)
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Ascarite II

GFS Chemicals
www.gfschemicals.com
P.O. Box 245
Powell, OH  43065
Phone: 614-881-5501
FAX: 614-881-5989
Toll free: 800-858-9682

Thomas Scientific
www.thomassci.com
P.O. Box 99
Swedesboro, NJ  08085-6099
Phone: 609-467-2000
FAX: 609-467-3087
Toll free: 800-345-2100
Toll free FAX: 800-345-5232

P.W. Perkins Co., Inc.
www.pwperkins.com
856-769-3525

Fisher Scientific
www.fishersci.com
711 Forbes Avenue
Pittsburgh, PA  15219-4785
Phone: 201-467-6400
FAX: 201-379-7415
Toll free: 800-776-7000
Toll free FAX: 800-926-1166
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Electronic Relay Switches

Crydom Inc.
9525 Chesapeake Dr.
San Diego, CA  92123
800-827-9366
FAX: 619-715-7280

Potter & Brumfield Products Div.
Siemens Electromechanical
Components, Inc.
200 S. Richland Creek Dr.
Princeton, IN  47671-0001
info@ae.sec.siemens.com
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E Configuration Grammar

Introduction

The LI-840 communicates exclusively through a serial interface.  The following discussion
describes how to implement a synchronized communication protocol.

LI-840 Communications and XML

The configuration grammar used to communicate with the LI-840 is based upon a subset of
the eXtensible Markup Language (XML).  XML relies on the use of tags to "Markup", or give
structural rules to a set of data.

A tag is a descriptive identifier, enclosed between a less than (<) and a greater than (>)
symbol, used in part to describe a piece of data.  For example, <NAME> is a tag that
describes a person's name.  Each tag must have a corresponding end tag, denoted by '/'.
Extending the example above, the end tag of <NAME> is </NAME>.
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Elements are the basic unit of XML content.  An element consists of a start tag and an end tag,
and everything in between.  For example, consider the following element:

<NAME>George</NAME>.

In this example, <NAME> (start tag) and </NAME> (end tag) comprise the markup, and "George"
comprises the data.  Because XML is extensible, tags can be defined specifically for the data
they are meant to describe.

Elements can also contain other elements other than data.

<NAME>
<FIRST>George</FIRST>
<LAST>Smith</LAST>

</NAME>

In this example, the outermost element <NAME> emcompasses two other elements that contain
data.  All elements combined make up the XML document.
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Connecting and Configuring Data Output

The LI-840 communicates through a serial port on the front of the instrument.  This port is
configured as follows:

Baud Rate: 9600 bps
Data Bits: 8
Parity: None
Stop Bits: 1
Flow Control: None

After a serial connection is established, the LI-840 will immediately send data out the serial
port in the manner in which it was configured previously.  In order to reconfigure the LI-840
to output specific data values, you must send the RS-232 portion of the XML grammar to the
instrument with the desired values "turned on".  To "turn on" the data value, set the value of
the element to TRUE.  As an example, the following string is sent to the instrument after a
connection has been made between the computer (using the Windows® application software)
and the LI-840:

<LI840>
<CFG>

<OUTRATE>1</OUTRATE>
</CFG>
<RS232>

<STRIP>FALSE</STRIP>
<ECHO>FALSE</ECHO>
<CELL TEMP>TRUE</CELL TEMP>
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<CO2>TRUE</CO2>
<CO2ABS>FALSE</CO2ABS>
<CELLPRES>TRUE</CELLPRES>
<IVOLT>TRUE</IVOLT>

</RS232>
</LI840>

Sending Data to the LI-840

To send data to the LI-840, each string must end with a '\n' to ensure that the LI-840 can parse
consecutive commands.

After data have been sent to the LI-840, the instrument replies with:

<LI840><ACK>TRUE</ACK></LI840>

if the XML was received and parsed correctly.  If there was an error in the XML, the
following is sent:

<LI840><ACK>FALSE</ACK></LI840>.

For example, suppose that you would like to reconfigure the LI-840 to stop outputting cell
temperature.  Here is the command to send to the LI-840:

<LI840><RS232><CELLTEMP>FALSE</CELLTEMP></RS232></LI840>

If the command was received correctly, the LI-840 replies with
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<LI840><ACK>TRUE</ACK></LI840>.

Reading Data From the LI-840

The LI-840 can send data continuously.  To determine where one message ends and the next
begins, each XML document sent from the LI-840 is delimited with a '\n' (0x10) character.

Polling the Current State of the LI-840

The LI-840 can be polled for individual sets of data by sending an XML document with a '?'
in place of the set of elements requested.  The element sets that can be requested include the
data set, the current configuration, and the entire state of the instrument.

Sending this command:

<LI840><DATA>?</DATA></LI840>

instructs the LI-840 to send the most recent set of data values (as configured) as an XML
document.

Sending this command:

<LI840><CFG>?</CFG></LI840>
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instructs the LI-840 to send an XML document containing all of the configuration
information, including heater status, filter settings, DACs, and alarms.

To receive the entire state of the instrument as an XML document, send this command:

<LI840>?</LI840>.

Calibration

The LI-840 calibration (zero and span) can be performed using XML grammar.  This is
accomplished in three steps:

1. Send the calibration command to the LI-840.

<LI840>
<CAL>

<DATE>{iso date}</DATE>
<CO2ZERO>{bool}</CO2ZERO>
<CO2SPAN>{int}</CO2SPAN>

</CAL>
</LI840>

2. An acknowledgement is returned from the LI-840 if the command was accepted.

<LI840><ACK>TRUE</ACK></LI840>
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3. After a few seconds, all of the calibration information is returned from the LI-840,
indicating that it has finished the zero and/or span.

<LI840>
<CAL>

<CO2LASTSPAN>{iso date}</CO2LASTSPAN>
<CO2LASTZERO>{iso date}</CO2LASTZERO>
<CO2KZERO>{float}</CO2KZERO>
<CO2KSPAN>{float}</CO2KSPAN>

</CAL>
</LI840>

If the calibration can not be performed, an ERROR is sent:

<LI840><ERROR>{Error Text}</ERROR></LI840>.

To Zero the LI-840

1. Send the XML command to initiate the zero.

<LI840>
<CAL>

<DATE>YYYY-MM-DD</DATE>
<CO2ZERO>TRUE</CO2ZERO>

</CAL>
</LI840>
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2. Wait for the acknowledgement.

3. Wait for the date to be returned to verify the zero operation succeeded.  If the operation
fails an <ERROR> will be sent.

To Span the LI-840

1. Send the XML command to initiate the span.

<LI840>
<CAL>

<DATE>YYYY-MM-DD</DATE>
<CO2SPAN>Gas Concentration</CO2SPAN>

</CAL>
</LI840>

2. Wait for the acknowledgement.

3. Wait for the date to be returned to verify the span operation succeeded.  If the operation
fails an <ERROR> will be sent.

LI-840 XML Grammar and Element Description

Data Types in the XML Grammar
{val | val |...}

The value will be a member of the specified set.  | = or.
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{bool}
Boolean values, TRUE | FALSE.

{float}
Floating point values in decimal or exponential notation.

{int}
Integers.

{iso date}
A date in the ISO format.  4 digit year - 2 digit month - 2 digit day.
Example: 2002-04-27.

XML Grammar

<LI840>
<ACK>{bool}</ACK>
<VER>{string}</VER>
<DATA>

<CO2>{float}</CO2>
<CO2ABS>{float}</CO2ABS>
<H2O>{float}</H2O>
<H2ODEWPOINT>{float}</H2ODEWPOINT>
<H2OABS>{float}</H2OABS>
<CELLTEMP>{float}</CELLTEMP>
<CELLPRES>{float}</CELLPRES>
<IVOLT>{float}</IVOLT>
<RAW>

<CO2>{int}</CO2>
<CO2REF>{int}</CO2REF>
<H2O>{int}</H2O>
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<H2OREF>{int}</H2OREF>
</RAW>

</DATA>
<RS232>

<CO2>{bool}</CO2>
<CO2ABS>{bool}</CO2ABS>
<H2O>{float}</H2O>
<H2ODEWPOINT>{bool}</H2ODEWPOINT>
<H2OABS>{bool}</H2OABS>
<CELLTEMP>{bool}</CELLTEMP>
<CELLPRES>{bool}</CELLPRES>
<IVOLT>{bool}</IVOLT>
<STRIP>{bool}</STRIP>
<ECHO>{bool}</ECHO>
<RAW>

<CO2>{bool}</CO2>
<CO2REF>{bool}</CO2REF>
<H2O>{bool}</H2O>
<H2OREF>{bool}</H2OREF>

</RAW>
</RS232>
<CFG>

<OUTRATE>{float}</OUTRATE>
<HEATER>{bool}</HEATER>
<PCOMP>{bool}</PCOMP>
<FILTER>{int}</FILTER>
<ALARMS>

<ENABLED>{bool}</ENABLED>
<SOURCE>H2O | CO2<SOURCE>
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<HIGH>{float}</HIGH>
<HDEAD>{float}</HDEAD>
<LOW>{float}</LOW>
<LDEAD>{float}</LDEAD>

</ALARMS>
<BENCH>{5|14}</BENCH>
<SPAN>{int}</SPAN>
<DACS>

<RANGE>{2.5|5.0}</RANGE>
<SET1>{float}</SET1>
<SET2>{float}</SET2>
<D1>{NONE|CO2|H2O|H2ODP|CELLTEMP|CELLPRES}</D1>
<D2>{NONE|CO2|H2O|H2ODP|CELLTEMP|CELLPRES}</D2>

</DACS>
</CFG>
<CAL>

<DATE>{iso date}</DATE>
<CO2ZERO>{bool}</CO2ZERO>
<CO2SPAN>{int}</CO2SPAN>
<H2OZERO>{bool}</H2OZERO>
<H2OSPAN>{float}</H2OSPAN>

<CO2KZERO>{float}</CO2KZERO>
<CO2KSPAN>{float}</CO2KSPAN>
<H2OZERO>{float}</H2OZERO>
<H2OKSPAN>{float}</H2OKSPAN>

or
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<CO2LASTZERO>{iso date}</CO2LASTZERO>
<CO2LASTSPAN>{iso date}</CO2LASTSPAN>

<H2OLASTZERO>{iso date}</H2OLASTZERO>
<H2OLASTSPAN>{iso date}</H2OLASTSPAN>

</CAL>
<POLY>

<DATE>{string}</DATE>
<BB>{float}</BB>
<XS>{float}</XS>
<RESET>{bool}</RESET>
<CO2>

<A1>{float}</A1>
<A2>{float}</A2>
<A3>{float}</A3>
<A4>{float}</A4>
<A5>{float}</A5>

</CO2>
<H2O>

<A1>{float}</A1>
<A2>{float}</A2>
<A3>{float}</A3>

</H2O>
</POLY>
<ERROR>{string}</ERROR>

</LI840>
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Element Description

Tag Parent Value(s) R/W Comments

<LI840> N/A (root) <ACK>
<VER>
<ERROR>
<DATA>
<RS232>
<CFG>
<CAL>
?

<LI840> is the root tag for
all XML statements.
A ? outputs entire XML
document.

Examples:
<LI840>?</LI840>
<LI840><ACK>TRUE</ACK></LI840>
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Tag Parent Value(s) R/W Comments

<DATA> <LI840> <CO2>
<CO2ABS>
<H2O>
<H2ODEWPOINT>
<H2OABS>
<CELLTEMP>
<CELLPRES>
<IVOLT>
<RAW>
?

<DATA> contains all
data values sent from
the LI-840.  All of the
elements within the
DATA tag are readable
only.  A ? requests all
data values to be
output.

Examples:
<LI840><DATA><CO2>2.34e2</CO2><IVOLT>1.5e2</IVOLT></DATA></LI840>
<LI840><DATA>?</DATA></LI840>



Appendix E

Appendix E E-15

Tag Parent Value(s) R/W Comments

<CO2> <DATA> Float R CO2 in ppm
<CO2ABS> <DATA> Float R CO2 absorption
<H2O> <DATA> Float R H2O in ppt (mmol/mol)
<H2ODEWPOINT> <DATA> Float R H2O in °C
<H2OABS> <DATA> Float R H2O absorption
<CELLTEMP> <DATA> Float R Cell temperature
<CELLPRES> <DATA> Float R Cell pressure
<IVOLT> <DATA> Float R Input voltage
<RAW> <DATA> <CO2> Raw detector readings

<CO2REF>
<H2O>
<H2OREF>

Examples:
<LI840><DATA><CELLTEMP>5.16E1</CELLTEMP><CELLPRES>9.742E1</CELLPRES>
<CO2>6.17E2</CO2><CO2ABS>8.94E2</CO2ABS>DATA></LI840>
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Tag Parent Value(s) R/W Comments

<CO2> <RAW> Integer R
<CO2REF> <RAW> Integer R
<H2O> <RAW> Integer R
<H2OREF> <RAW> Integer R

Tag Parent Value(s) R/W Comments

<RS232> <LI840> <CO2>
<CO2ABS>
<H2O>
<H2ODEWPOINT>
<H2OABS>
<CELLTEMP>
<CELLPRES>
<IVOLT>
<RAW>
<ECHO>
<STRIP>

Setting <RS232> values
will determine what
values are output in
<DATA>
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Tag Parent Value(s) R/W Comments

<CO2> <RS232> TRUE | FALSE R/W CO2 in ppm
<CO2ABS> <RS232> TRUE | FALSE R/W CO2 absorption
<H2O> <RS232> TRUE | FALSE R/W H2O in ppt
<H2ODEWPOINT> <RS232> TRUE | FALSE R/W H2O dew point
<H2OABS> <RS232> TRUE | FALSE R/W H2O absorption
<CELLTEMP> <RS232> TRUE | FALSE R/W Cell temperature
<CELLPRES> <RS232> TRUE | FALSE R/W Cell pressure
<IVOLT> <RS232> TRUE | FALSE R/W Input voltage
<RAW> <RS232> <CO2> Raw detector readings

<CO2REF>
<H2O>
<H2OREF>

<ECHO> <RS232> TRUE | FALSE R/W Echo commands sent
to LI-840

<STRIP> <RS232> TRUE | FALSE R/W Strip XML from all
data sent

Example:
<LI840><CFG><OUTRATE>0.5</OUTRATE></CFG><RS232><STRIP>FALSE</STRIP>
<ECHO>FALSE</ECHO><CELLTEMP>TRUE</CELLTEMP><CO2ABS>TRUE</CO2ABS>
<CO2>TRUE</CO2><CELLPRES>TRUE</CELLPRES><IVOLT>TRUE</IVOLT><RAW>TRUE
</RAW></RS232></LI840>
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Tag Parent Value(s) R/W Comments

<CO2> <RAW> TRUE | FALSE R/W
<CO2REF> <RAW> TRUE | FALSE R/W
<H2O> <RAW> TRUE | FALSE R/W
<H2OREF> <RAW> TRUE | FALSE R/W

Tag Parent Value(s) R/W Comments

<CFG> <LI840> <OUTRATE>
<HEATER>
<PCOMP>
<DOFFSET>
<FILTER>
<ALARMS>
<DACS>
<BENCH>
<SPAN>
?

Elements within the <CFG>
tag control system settings.

Example:
<LI840><CFG><HEATER>TRUE</HEATER><PCOMP>TRUE</PCOMP></CFG></LI840>
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Tag Parent Value(s) R/W Comments

<OUTRATE> <CFG> 0.5 to 20 R/W Output data every N
seconds (0.5 s increments).

<HEATER> <CFG> TRUE | FALSE R/W Turn heater on/off.
<PCOMP> <CFG> TRUE | FALSE R/W Pressure compensation

on/off.
<FILTER> <CFG> 0 to 20 R/W Set a 0 to 20 second filter.
<ALARMS> <CFG> <ENABLED>

<HIGH>
<HDEAD>
<LOW>
<LDEAD>

High and low alarm
settings.

<DACS> <CFG> <RANGE>
<SET1>
<SET2>
<D1>
<D2>

DAC outputs.

<BENCH> <CFG> 14 R Optical bench length (cm).
<SPAN> <CFG> Integer R/W Span range setting (0-

3000).
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Tag Parent Value(s) R/W Comments

<ENABLED> <ALARMS> TRUE | FALSE R/W Enable alarms.
<SOURCE> <ALARMS> CO2 | H2O R/W Channel (CO2:ppm,

H2O:ppt)
<HIGH> <ALARMS> Float R/W High alarm on at this value.
<HDEAD> <ALARMS> Float R/W High alarm off at this value.
<LOW> <ALARMS> Float R/W Low alarm on at this value.
<LDEAD> <ALARMS> Float R/W Low alarm off at this value.

Example:
<LI840<LI840><CFG><ALARMS><ENABLED>TRUE</ENABLED><SOURCE>H2O</SOURCE>
<HIGH>1600</HIGH><HDEAD>1500</HDEAD><LOW>200</LOW><LDEAD>300</LDEAD>
</ALARMS></CFG></LI840>
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Tag Parent Value(s) R/W Comments

<RANGE> <DACS> 2.5 | 5.0 R/W Output voltage.  2.5V or 5.0V.
<SET1> <DACS> Float R/W Set DAC output to value (DACS must

be NONE)
<SET2> <DACS> Float R/W Set DAC output to value (DACS must

be NONE)
<D1> <DACS> CO2 | H2O |

H2ODEWPOINT |
CELLPRES |
CELLTEMP |
NONE

R/W DAC1

<D2> <DACS> CO2 | H2O |
H2ODEWPOINT |
CELLPRES |
CELLTEMP |
NONE

R/W DAC2

Example:
<LI840><CFG><DACS><RANGE>2.5</RANGE><D1>CO2</D1><D2>CELLTEMP</D2></DACS><
/CFG></LI840>
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Tag Parent Value(s) R/W Comments

<CAL> <LI840> <DATE>
<H2OZERO>
<H2OSPAN>
<H2OLASTZERO>
<H2OLASTSPAN>
<H2OKZERO>
<H2OKSPAN>
<CO2ZERO>
<CO2SPAN>
<CO2LASTZERO>
<CO2LASTSPAN>
<CO2KZERO>
<CO2KSPAN>
<POLY>

Calibration
parameters.  When
calibrating, <DATE>
must be paired with a
<CO2ZERO> or a
<CO2SPAN>, or a
<H2OZERO> or
<H2OSPAN>.
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Tag Parent Value(s) R/W Comments

<DATE> <CAL> 20 character date W The date the calibration is taking place.
<H2OZERO> <CAL> TRUE | FALSE W Start H2O zero.
<H2OSPAN> <CAL> Float (H2O °C) W Start H2O span.
<H2OLASTZERO> <CAL> 20 character date R Date the LI-840 was last zeroed.
<H2OLASTSPAN> <CAL> 20 character date R Date the LI-840 was last spanned.
<H2OKZERO> <CAL> Float R/W Calibration constant.
<H2OKSPAN> <CAL> Float R/W Calibration constant.
<CO2ZERO> <CAL> TRUE | FALSE W Start a CO2 zero.
<CO2SPAN> <CAL> Float (CO2 ppm) W Start a CO2 span.
<CO2LASTZERO> <CAL> 20 character date R The date the LI-840 was last zeroed.
<CO2LASTSPAN> <CAL> 20 character date R The date the LI-840 was last spanned.
<CO2KZERO> <CAL> Float R/W Calibration constant.
<CO2KSPAN> <CAL> Float R/W Calibration constant.
<POLY> <CAL> <DATE> R/W Factory calibration date.

<BB> R/W Band broadening.
<XS> R/W Cross sensitivity.
<CO2> R/W CO2 coefficients.
<H2O> R/W H2O coefficients.
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Examples:
To Zero:
<LI840><CAL><DATE>2001-02-07</DATE><CO2ZERO>TRUE</CO2ZERO></CAL></LI840>
To Span:
<LI840><CAL><DATE>2001-02-07</DATE><CO2SPAN>1000</CO2SPAN></CAL></LI840>
Possible LI-840 Replies
<LI840><ACK>TRUE</ACK></LI840>
<LI840><ERROR>{ErrorText}</ERROR></LI840>
<LI840><CAL><CO2LASTSPAN>
{isodate}</CO2LASTSPAN><CO2LASTZERO>{isodate}</CO2LASTZERO><CO2KZERO>{float}
</CO2KZERO> <CO2KSPAN>{float}</CO2KSPAN> </CAL></LI840>

Tag Parent Value(s) R/W Comments

<DATE> <POLY> 20 character
date

R/W Factory calibration date.

<BB> <POLY> Float R/W Band broadening value.
<XS> <POLY> Float R/W Cross sensitivity value.
<CO2> <POLY> <A1>

<A2>
<A3>
<A4>
<A5>

R/W Floating point coefficients for the CO2
calibration polynomial.

<H2O> <POLY> <A1>
<A2>
<A3>

R/W Floating point coefficients for the H2O
calibration polynomial.
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Tag Parent Value(s) R/W Comments

<ACK> <LI840> TRUE | FALSE R Acknowledgement to a send command.
<VER> <LI840> Text R Embedded software version.
<ERROR> <LI840> Text R Error.  Includes a message.



Warranty
Each LI-COR, inc. instrument is warranted by LI-COR, inc. to be free from defects in material and workmanship; however, LI-COR, inc.'s sole
obligation under this warranty shall be to repair or replace any part of the instrument which LI-COR, inc.'s examination discloses to have been
defective in material or workmanship without charge and only under the following conditions, which are:

1.  The defects are called to the attention of LI-COR, inc. in Lincoln, Nebraska, in writing within one year after the shipping date of the
instrument.
2.  The instrument has not been maintained, repaired, or altered by anyone who was not approved by LI-COR, inc.
3.  The instrument was used in the normal, proper, and ordinary manner and has not been abused, altered, misused, neglected, involved in and
accident or damaged by act of God or other casualty.
4.  The purchaser, whether it is a DISTRIBUTOR or direct customer of LI-COR or a DISTRIBUTOR'S customer, packs and ships or delivers
the instrument to LI-COR, inc. at LI-COR inc.'s factory in Lincoln, Nebraska, U.S.A. within 30 days after LI-COR, inc. has received written
notice of the defect.  Unless other arrangements have been made in writing, transportation to LI-COR, inc. (by air unless otherwise authorized
by LI-COR, inc.) is at customer expense.
5.  No-charge repair parts may be sent at LI-COR, inc.'s sole discretion to the purchaser for installation by purchaser.
6.  LI-COR, inc.'s liability is limited to repair or replace any part of the instrument without charge if LI-COR, inc.'s examination disclosed that
part to have been defective in material or workmanship.

There are no warranties, express or implied, including but not limited to any implied warranty of merchantability of fitness for a
particular purpose on underwater cables or on expendables such as batteries, lamps, thermocouples and calibrations.

Other than the obligation of LI-COR, inc. expressly set forth herein, LI-COR, inc. disclaims all warranties of merchantability or fitness
for a particular purpose.  The foregoing constitutes LI-COR, inc.'s sole obligation and liability with respect to damages resulting from
the use or performance of the instrument and in no event shall LI-COR, inc. or its representatives be liable for damages beyond the
price paid for the instrument, or for direct, incidental or consequential damages.



The laws of some locations may not allow the exclusion or limitation on implied warranties or on incidental or consequential damages, so the
limitations herein may not apply directly.  This warranty gives you specific legal rights, and you may already have other rights which vary from
state to state.  All warranties that apply, whether included by this contract or by law, are limited to the time period of this warranty which is a
twelve-month period commencing from the date the instrument is shipped to a user who is a customer or eighteen months from the date of
shipment to LI-COR, inc.'s authorized distributor, whichever is earlier.

This warranty supersedes all warranties for products purchased prior to June 1, 1984, unless this warranty is later superseded.

DISTRIBUTOR or the DISTRIBUTOR'S customers may ship the instruments directly to LI-COR if they are unable to repair the instrument
themselves even though the DISTRIBUTOR has been approved for making such repairs and has agreed with the customer to make such repairs
as covered by this limited warranty.

Further information concerning this warranty may be obtained by writing or telephoning Warranty manager at LI-COR, inc.

IMPORTANT:  Please return the User Registration Card enclosed with your shipment so that we have an accurate record of your address.
Thank you.



LI-COR, inc.  ●   Environmental ●  4421 Superior Street  ●   P.O. Box 4425  ●   Lincoln, Nebraska  68504 USA
Phone: 402-467-3576  ●  FAX: 402-467-2819

Toll-free 1-800-447-3576 (U.S. & Canada)
E-mail: envsales@licor.com

Internet: http://www.licor.com

®
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